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1. GENERAL INFORMATION 
 
1.1. Title of Dataset 
Dense 3D pressure discomfort threshold (PDT) map of the human head, face and neck [Dataset] 
 
1.2. Author information 
In case of questions regarding the data files and data processing methods, please contact Toon 
Huysmans. For questions regarding study method and publication, please contact Maxim Smulders. 
 

Author/Lead Investigator/Data analyst 
Name:  Maxim Smulders 
ORCID:  0000-0001-9957-0991 
Institution:  Delft University of Technology 
Address:  Landbergstraat 15, 2628CE Delft, The Netherlands 
Email:  m.smulders@tudelft.nl 
 
Author/Investigator  
Name:  Lisanne N.M. van Dijk 
ORCID:  0000-0002-8626-7296 
Institution:  Crescent Medical B.V. 
Address:  Vlamingstraat 72A, 2611KZ Delft, The Netherlands 
 
Author/Investigator/Data analyst 
Name:  Yu (Wolf) Song 
ORCID:  0000-0002-9542-1312 

Institution:  Delft University of Technology 
Address:  Landbergstraat 15, 2628CE Delft, The Netherlands 
Email:  y.song@tudelft.nl 
 
Author/Investigator  
Name:  Peter Vink 
ORCID:  0000-0001-9985-3369 

Institution:  Delft University of Technology 
Address:  Landbergstraat 15, 2628CE Delft, The Netherlands 
Email:  p.vink@tudelft.nl 
 
Author/Principal Investigator/Lead data analyst 
Name:  Toon Huysmans 
ORCID:  0000-0001-7053-6458 
Institution1:  Faculty of Industrial Design Engineering, Delft University of Technology 
Address1:  Landbergstraat 15, 2628CE Delft, The Netherlands 
Email1:  t.huysmans@tudelft.nl 

Institution2: Imec-Vision Lab, Department of Physics, University of Antwerp 
Address2:  Universiteitsplein 1, B-2610 Antwerp, Belgium 
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1.3. Date of data collection 
2019-06-12 till 2019-06-28 
 
 
1.4. Geographic location of data collection 
Delft, The Netherlands 
 
 
1.5. Funding sources 
Information about funding sources that supported the collection of the data can be found in Table 1.  
 

Table 1 | Funding sources Smulders et al. (2022) 

Funding source Type of funding Project number 
Crescent Med Supporting this study by making 

manhours available 
– 

Dutch Research Council (NWO) Partly financed 18636 
Delft University of Technology Predominantly funded  

(man hours, lab, lab equipment, software 
licences, data storage, etc.) 

– 

 
 
1.6. Ethical approval 
This study was approved by the Delft University of Technology Human Research Ethical Committee 
(hrec.tudelft.nl) on 18 July 2019 (approval no. 772), in accordance with The Helsinki Declaration (World 
Medical Association, 2013). Research materials and method, including a ‘sticker allergic reaction test’, 
were evaluated with a medical doctor and approved by a Health, Safety and Environment Officer of the 
Delft University of Technology.  
 
Participants recognisable on pictures and 3D scans gave explicit permission to be recognisable in this 
publication. Other models are maps on a generic head model made of merging all 3D scans of all 
participants into one. 
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2. SHARING/ACCESS INFORMATION 
 
2.1. Licenses/restrictions placed on the data 
Attribution (CC BY 4.0). See also creativecommons.org/licenses/by/4.0/ for the full license. 
 
 
2.2. Links to publications that cite or use the data 
Smulders, M., van Dijk, L.N.M., Song, Y., Vink, P. and Huysmans, T. (2022) Dense 3D pressure 
discomfort threshold (PDT) map of the human head, face and neck: a new method for mapping human 
sensitivity. Applied Ergonomics, 107 (103919). https://doi.org/10.1016/j.apergo.2022.103919 
 
 
2.3. Data derived from other sources 
The SSM (from Principal Component 1 to PC50, ±3σ) was built with the CAESAR 3D Anthropometric 
Database (USA, Italy and The Netherlands, male and female, 18-65y, n=4309) by Robinette, K. M., 
Blackwell, S., Daanen, H., Boehmer, M., & Fleming, S. (2002). Civilian American and European surface 
anthropometry resource (CAESAR). The CAESAR dataset can be acquired at Shape Analysis:  
 

Shape Analysis 
Website: https://www.shapeanalysis.com/CAESAR.htm 
Phone: +44 (0) 7720851196 
Email: richard@shapeanalysis.com 

 
Please note that 117 3D scans from CAESAR could not be processed and were excluded from our 
model. Thus where the original dataset contains 4426 samples, this study used 4309. 
 
 
2.4. Recommended citation for this dataset 
Smulders, M., van Dijk, L.N.M., Song, Y., Vink, P. and Huysmans, T. (2022) Dense 3D pressure 
discomfort threshold (PDT) map of the human head, face and neck [Dataset]. In: 4TU.ResearchData. 
https://doi.org/10.4121/21482328



README Dense 3D pressure discomfort threshold (PDT) map of the human head, face and neck 
M. Smulders & T. Huysmans 2022 CC-BY 4.0 

 5 

 

3. DATA & FILE OVERVIEW 
 
3.1. File List 
 

Figure 1 | File list for Smulders et al. (2022) Dense 3D pressure discomfort threshold (PDT) map of the human head, face and neck [Dataset] 

File name File type Brief description Contents 
Smulders (2022) TUDELFT 
PDT_Mean_nonNorm.vtk 

*.vtk Non-normalised PDT (pressure discomfort threshold) data mapped on a TU Delft 
developed 3D geometry model of the human head, face and neck based on an 
mirrored average of 28 participants from Smulders et al. (2022). 

This model allows for 3D viewing PDT maps based on Smulders et al. (2022). 

PDT_all_mean 
PDT_all_std 
PDT_male_mean 
PDT_male_std 
PDT_female_mean 
PDT_female_std 
PDT_participant_01-29 (excl. 14) 

Smulders (2022) TUDELFT 
PDT_Mean_nonNorm.csv 

*.csv Non-normalised PDT data for each 3D point (x-, y-, z-coordinate) of a Smulders et 
al. (2022) based 3D geometry model of the human head, face and neck. " 

Smulders (2022) TUDELFT 
PDT_Mean_Norm.vtk 

*.vtk Normalised PDT (pressure discomfort threshold) data mapped on a TU Delft 
developed 3D geometry model of the human head, face and neck based on an 
mirrored average of 28 participants from Smulders et al. (2022). 

This model allows for 3D viewing PDT maps based on Smulders et al. (2022). 

PDT_all_mean 
PDT_all_std 
PDT_male_mean 
PDT_male_std 
PDT_female_mean 
PDT_female_std 
PDT_participant_01-29 (excl. 14) 

Smulders (2022) TUDELFT 
PDT_Mean_Norm.csv 

*.csv Normalised PDT data for each 3D point (x-, y-, z-coordinate) of a Smulders et al. 
(2022) based 3D geometry model of the human head, face and neck. " 

Smulders (2022) CAESAR 
PDT_Mean_nonNorm.vtk 

*.vtk Non-normalised PDT (pressure discomfort threshold) data mapped on a CAESAR 
(Robinette et al., 2002) based 3D geometry model of the human head, face and 
neck, of which principle components (PC) can be adjusted. 

This model allows to create custom Eigenmodels based on the CAESAR database 
with PDT maps based on Smulders et al. (2022). 

Model_Eigenmode_0001-0050 
PDT_all_mean 
PDT_all_std 
PDT_male_mean 
PDT_male_std 
PDT_female_mean 
PDT_female_std 
PDT_participant_01-29 (excl. 14) 

Smulders (2022) CAESAR 
PDT_Mean_nonNorm.csv 

*.csv Non-normalised PDT data for each 3D point (x-, y-, z-coordinate) of a CAESAR 
(Robinette et al., 2002) based 3D geometry model of the human head, face and 
neck. 

" 
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Smulders (2022) CAESAR 
PDT_Mean_Norm.vtk 

*.vtk Normalised PDT (pressure discomfort threshold) data mapped on a CAESAR 
(Robinette et al., 2002) based 3D geometry model of the human head, face and 
neck, of which principle components (PC) can be adjusted. 

This model allows to create custom Eigenmodels based on the CAESAR database 
with PDT maps based on Smulders et al. (2022). 

Model_Eigenmode_0001-0050 
PDT_all_mean 
PDT_all_std 
PDT_male_mean 
PDT_male_std 
PDT_female_mean 
PDT_female_std 
PDT_participant_01-29 (excl. 14) 

Smulders (2022) CAESAR 
PDT_Mean_Norm.csv 

*.csv Normalised PDT data for each 3D point (x-, y-, z-coordinate) of a CAESAR 
(Robinette et al., 2002) based 3D geometry model of the human head, face and 
neck. 

" 

Smulders (2022) OBJ 
PDT_maps.zip 

*.zip  
(*.obj) 

This ZIP folder contains OBJ (geometry definition file format) files for use in CAD 
(computer-aided design). 

Non-normalised and normalised version for CAESAR as 
TUDELFT 3D geometry models: 
PDT_all_mean 
PDT_all_std 
PDT_male_mean 
PDT_male_std 
PDT_female_mean 
PDT_female_std 

Smulders (2022) Original 
PDT_data.zip 

*.zip  
(*.obj & *.vtk) 

This ZIP folder contains the cleaned original PDT and landmark ID data of all 
participants, and the 3d geometry model based on all participants in the study of 
Smulders et al. (2022). 

original_Head (*.obj) 
Original_PDT_participant_01-29 (*.vtk) 

Smulders (2022) 
Participant_characteristics.csv 

*.csv Participant characteristics and anthropometry of  
Smulders et al. (2022). 

Participant ID 
Gender [male/female/x] 
Nationality 
Age [years] 
Stature length [cm] 
Weight [kg] 

" = Similar as above. 
Note: all *.vtk files are in ASCII. These can be opened in most text editors. 
 
3.1.1. Relationship between files 
Participant numbers in all files correspond to the same participant. 
*.csv files of the same name as the *.vtk files contain similar data, but store data differently. Where *.csv are comma separated values which can be opened in 
spreadsheets or text editors, *.vtk is an ASCII file which can be opened in VTK supported programs (e.g. ParaView) and text editors. 
 
 
3.2. Excluded data 
3D geometry of individual participants is excluded for privacy reasons and will not be provided outside of the research team, as stated in the Informed Consent 
agreement with participants and in line with the Human Research Ethics Committee of the Delft University of Technology (TU Delft) ruling.
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4. METHODOLOGICAL INFORMATION 
 
4.1. Description of methods used for collection/generation of data 
This method is described in Smulders, M., van Dijk, L.N.M., Song, Y., Vink, P. and Huysmans, T. (2022) 
Dense 3D pressure discomfort threshold (PDT) map of the human head, face and neck: a new method 
for mapping human sensitivity. Applied Ergonomics, 107 (103919). 
https://doi.org/10.1016/j.apergo.2022.103919 
 
Pressure Discomfort Threshold (PDT) was measured in 28 healthy subjects on 126 to 146 landmarks 
(135 on average) on the left side of the head, face and neck. No repeated trials were conducted. The 
landmarks’ 3D coordinates of each participant were captured by means of 3D scanning and mapped to 
a reference head. The PDT values of all participants were bilaterally mirrored and interpolated to create a 
complete 3D PDT map of the human head, face and neck. 
 
 
4.1.1. Participants 
14 female and 14 male (14 Dutch, 6 Chinese, 3 Italian, 1 Costa Rican, 1 Thai, 1 American, 1 Belgian and 
1 Danish-German) adults with no history of a stroke, epilepsy, seizure, stenosis, and/or injuries or 
physical complaints at the face, neck and/or head in the past six months participated in this study (see 
Table 2). Participants with tape and/or glue allergies were excluded from the experiment, as sticker 
landmarks were used on the skin.  
 

Table 2 | Characteristics of participants. 

  Mean SD 
Female (n=14) Age [Years] 35.4 14.4 

Stature [cm] 168.5 5.0 
Weight [Kg] 59.2 7.8 

Male (n=14) Age [Years] 31.5 11.9 
Stature [cm] 179.1 9.5 
Weight [Kg] 73.6 7.9 

 
Please note that subject no. 14 is excluded from all datasets, due to incompletion of the experiment by 
this participant (due to a computer error with data loss and insufficient time to complete). 
 

The full dataset on participant characteristics (excl. subject no. 14) can be found in 'Smulders (2022) 
Participant_ characteristics.csv'. 

 
 
4.1.2. Apparatus 
In this study, a Mecmesin AFG 500N pressure gauge was used to apply pressure stimuli perpendicular 
to the skin on landmarked locations (see Figure 2), capturing the PDT in Newtons.  
 
A 3D printed ø10mm PLA pressure gauge probe with rounded edges (3mm fillet) (see Figure 2) was 
used to capture small facial features (e.g. nose tip) for a high-density measurement. Rounded edges 
were used to prevent high pressure at the surface edge. PLA (Polylactic acid) was chosen for its 
biocompatibility and low thermal conductivity regarding metal probes, as a cold sensation might 
influence thermal comfort of the user. 
 
Ø12mm stickers were used as landmarks. A hair cap was used to hygienically cover the hair, in order to 
place a head-cap with an EEG 10-20 landmarks grid (Jasper, 1958) (see Figure 3Figure 4) to landmark 
the positions on the head. An Artec Eva was used to 3D scan the head, face and neck of participants, 
capturing both 3D geometry as textures (see Figure 5). Artec Studio software was used to capture 3D 
coordinates of placed landmark stickers. A Canon EOS 60D camera was used to make reference photos 
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of the landmarks. A massage seat was used to support the head (preventing movement and muscle 
activation caused by giving counter-pressure) while probing PDT. 
 
 

 
Figure 2 | Mecmesin AFG 500N pressure gauge with 3D printed PLA Ø10mm tip, and participant with EEG 10-20 

landmark grid headcap and landmark stickers on the face, head and neck. Researcher gradually increasing  
pressure on a landmark with pressure gaug. 

 
4.1.3. Procedure 
Written consent was obtained prior to the experiment. Stature height and weight were measured, and 
age, gender and ethnicity/nationality were noted.  
 
Landmark placement and capture 
Participants were asked to clean their face and neck with hypoallergenic cleaning wipes for better 
landmark sticker adhesion. Researchers cleaned their hands with disinfectant alcohol gel. 
Participants with long hair were asked to make a bun to the right side of the head, next to the ear, to 
minimise influence of the hair on the 3D scan (in order to scan close to the actual scalp) and PDT 
measurements (see Figure 3).  
 
Participants then sat down, where two researchers placed a clean hair cap over the hair and pushed hair 
underneath as much as possible. Next, the head-cap with the EEG 10-20 landmark grid was placed on 
top. 126 to 146 landmarks (135 on average) were placed by two researchers on the face and neck (see 
Figure 3). Some of these markers were placed based on clearly identifiable anatomical landmarks (e.g. 
tragus, lateralis ad alare, philtrum, protuberantia mentalis, and commissura labiorum, as indicated on a 
reference model), where others were at intermediate locations (see Figure 4). The goal was to gain a 
compact spread over the entire head, face and neck, with a distance of 2-3 cm between landmarks. 
Some participants with broad necks got an extra row of landmark-stickers in the back of the neck and 
some got extra landmarks around the ear to cover some ‘blind spots’.  
 
With an Artec Eva 3D scanner, the geometry of the head, face and neck, and the landmark coordinates 
were captured (see Figure 5). Thereafter reference photos of the landmarks where made. 
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Figure 3 | Placing marker-stickers on the face and neck. The long hair of the participant  
was bound in a bun to the right side of the head, in order to scan the left scalp shape. 

 
 

 
Figure 4 | Landmark location reference model (black markers only). 

 
 

 
Figure 5 | 3D scanning the head, face and neck in order to capture the geometry and  

marker locations, using a rotating seat, Artec Eva 3D scanner and a reference monitor. 
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Sensitivity experiment procedure 
All marker-points were divided over four zones, to limit the number of postural changes, which were 
passed in order. For pressure on the head (zone 1) and the back of the neck (zone 4), participants were 
asked to take position A (see Figure 6): with the face down on the head support. For pressure on the 
face (zone 2), participants were asked to take position B (see Figure 6): with the face sideways on the 
headrest, respectively. For pressure on the lower chin and neck front (zone 3), participants were asked to 
take position C (see Figure 6): sitting upright, respectively.  
 

 
Figure 6 | Position A: subject in massage seat, face down. Position B: subject in massage seat, face sideways. 

Position C: subject in massage seat, head up.   

 
The experiment was conducted in two sessions: the first was for priming, where participants got 
acquainted with the procedure with a limited number of landmarks being pressed. Thereafter participants 
were asked to stand up and have a five-minute break, to limit the impact of the priming on the second 
session. In the second session, all landmarks in each zone were probed in a randomised order and data 
was collected. For each landmark, a researcher gradually applied pressure on the centre of the landmark 
with the probe of the pressure gauge along the normal direction of the face/head/neck in this region (see 
Figure 2). Participants were instructed to slap with their hand on the arm rest when applied pressure was 
considered uncomfortable. Pressure was then released by the researcher and the recorded maximum 
force was documented. 
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4.2. Methods for processing the data 
Below describes how the submitted data were generated from the raw or collected data. Software used 
for this can be found in Table 3. 
 

Table 3 | Software used to process data 

Software Developer Website 
Artec Studio 14 Artec 3D www.artec3d.com 
Custom Phyton script (VTK library) Toon Huysmans – 
Excel Microsoft www.microsoft.com 
ParaView Sandia National Laboratories 

Kitware Inc. 
Los Alamos National Laboratory 

www.paraview.org 

R3DS Wrap 3.4 Russian3DScanner LLC www.russian3dscanner.com 
Rhinoceros Robert McNeil & Friends www.rhino3d.com 
Sensitivity Mapper (Phyton) Toon Huysmans – 
VTK library Kitware Inc. www.vtk.org 

 
 
4.2.1. 3D scan processing 
In Artec Studio 14, 3D scans of each subject were pre-processed (e.g. fill holes), aligned and merged as 
a 3D textured mesh, which was exported in *.obj format. 
 
 
4.2.2. 3D marker allocation and numbering 
A Python program was developed to allocate the correct marker ID number to each landmark (see Figure 
7). Marker IDs were visually identified based on the allocated number in the scan, or when illegible, the 
reference photos were used. 
 

 
Figure 7 | Screenshot of 3D marker allocation and numbering program by T. Huysmans. 
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4.2.3. Intra-individual pressure distribution processing 
To compare relative PDT differences between participants, the PDT’s were normalised per subject by 
expressing the PDT as a percentage of the mean of the top 5% PDT of the individual subject. 
Mean5%MaxPDT was chosen to limit the effect of outliers on the normalisation. 
 
 
4.2.4. Mean 3D head model 
To create the PDT map, a mean head model was made from the 3D scans of all subjects (see Figure 8). 
The 3D scan of each subject was rigidly aligned with a standard head mesh template in R3DS Wrap 3.4, 
based on predefined landmarks on the glabella, nose apex, between the alar nasal sulcus-nasolabial 
sulcus, philtrum, ear lobule and protuberantia occipitalis externa. Next, the mesh template was wrapped 
on the 3D scan while matching the predefined landmarks (i.e. elastically deform the mesh template to 
match the shape of the 3D scan), which utilises a variant of the non-rigid iterative closest points algorithm 
(Dyke et al., 2020). The results were visually checked and interactively adjusted where needed. This 
process was iterated over all 28 3D scans. 
 
Based on these 28 3D scans, a mean head model was made using a Python script (Huysmans, Goto, 
Molenbroek, & Goossens, 2020), where all meshes were aligned (Gower, 1975). The mean coordinates 
were calculated for each vertex (point), from which the mean head mesh was created. The complete 
process ensures a point-to-point correspondence between the mean model and each 3D scan. 
 
 

 
Figure 8 | Mean head model based on 3D scans of all participants (n=28). 

 
The mean 3D head model can be found in 'Smulders (2022) Original PDT_data.zip'. 
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4.2.5. Bilaterally symmetric modelling 
Using the one-to-one correspondence between the mean model and each participant’s 3D scan, 
landmark locations of each 3D scan were mapped onto the average head model. Note that, due to the 
manual marker placement, the marker locations can slightly differ between subjects, and thus also end 
up at slightly different locations of the average head, as shown in Figure 9. 
 
 

 
Figure 9 | Landmark locations (n=28). Each colour represents one specific landmark number, showing the proximity 

of placement of landmarks of all participants. As shown, landmarks form clusters on the head and face,  
where there is more scattering in the neck. The reason for this is that participants with wider necks  

had an extra row of landmarks. 

 
Bilateral symmetry was accomplished by utilizing a left-right correspondence on the average head, which 
was obtained by wrapping a left-right mirrored version of the average head to the original average head. 
By averaging the vertex coordinates of two head models, an average and symmetric head model was 
obtained.  
 
In creating the symmetric average model, clipping of the surface to a region of interest (ROI) was needed. 
To this end the ROI was limited to those parts of the model where for 90% of the subjects there was at 
least 1 marker within a 30 mm range. 
 

The full dataset can be found in 'Smulders (2022) Original PDT_data.zip'. 
 
 
4.2.6. 3D pressure discomfort threshold map 
PDT values between markers were obtained from a smooth interpolation of the values at landmark 
locations to the rest of the average head model, by solving for a solution with a vanishing Laplacian at all 
vertices (method B from Oostendorp, van Oosterom, and Huiskamp (1989)) (see Figure 10). The resulting 
symmetric PDT maps, defined on the symmetric average head model, allowed to calculate summary 
statistics of PDT over the full set of subjects or for gender-specific sub-groups. The same approach was 
used to create maps of normalised PDT values (Mean5%MaxPDT). 
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Figure 10 | Actual PDT values (by colour of landmark) and positions of landmarks, with the interpolated 

 PDT on the mean 3D head model in Newtons of one participant (n=1). Please note that shading is  
on to improve depth perception, which may affect colour (and thus PDT value) interpretation. 

 
The full dataset can be found in 'Smulders (2022) TUDELFT PDT_Mean_nonNorm.vtk'  
and 'Smulders (2022) TUDELFT PDT_Mean_Norm.vtk'. 

 
 
To aid designers and engineers e.g. in CAD, the average PDT was also mapped to a statistical shape 
model (SSM) of the human head developed on the CAESAR 3D Anthropometric Database (Robinette, 
Blackwell, Daanen, Boehmer, & Fleming, 2002) (see Figure 10). While the PDT on different geometric 
heads is available, it is an approximation using the mean PDT data (n=28) and may not be as 
representative for the respective populations they are mapped upon.  
 

The full dataset can be found in 'Smulders (2022) CAESAR PDT_Mean_nonNorm.vtk'  
and 'Smulders (2022) CAESAR PDT_Mean_Norm.vtk'. 

 
 
4.2.7. Statistical analysis  
Where previous studies like Shah and Luximon (2021) statistically analyse individual landmarks, this study 
uses a method with anatomical independent landmarking in order to achieve greater landmark density. 
This method however does not allow for landmark based analysis, as placed landmarks do not always 
correspond between participants within this study and previous studies. Therefore, zones are drawn to 
conduct statistical analysis and compare results with previous studies. Zones scalp, forehead, temple, 
back head, nose, cheekbone, cheek, mouth, jaw-chin, neck front, and neck back are based on zones of 
potential interest for different wearables, anatomical features, underlying tissue, landmark locations and 
observed PDT transitions (see Figure 11).  
 
A Mann-Whitney-Wilcoxon test (two-tailed) was used for comparing gender differences and a Kruskal-
Wallis test for identifying difference in median PDT across zones (p<.05). A Dunn's Post-hoc (pairwise) 
tests was used to identify differences per combination of zones, which was compensated for multiple 
comparisons by controlling False Discovery Rate through the Benjamini-Hochberg procedure.  
Analysis of gender difference was conducted based on both absolute- and normalised PDT data 
(Mean5%MaxPDT). All other statistical analysis were conducted based on absolute PDT values only (thus 
no interpolated nor mirrored data were used). 
 

Statistical analysis results can be found in 'Smulders, M., van Dijk, L.N.M., Song, Y., Vink, P. and 
Huysmans, T. (2022) Dense 3D pressure discomfort threshold (PDT) map of the human head, face 
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and neck: a new method for mapping human sensitivity. Applied Ergonomics, 107 (103919). 
https://doi.org/10.1016/j.apergo.2022.103919 

 
 

 
Figure 11 | PDT values in kPa per landmark within zones of all participants (n=28), males (n=14) and females (n=14), 

anterior, lateral and posterior view. Please note that shading is on to improve depth perception,  
which may affect colour (and thus PDT value) interpretation. 
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4.3. Instrument- or software-specific information 
needed to interpret the data 

 
4.3.1. Reading *.vtk 
We recommend to open the *.vtk files in ParaView (see Table 4), a free and opensource post-processing 
visualization engine software. For instructions on how to view the models in ParaView, please see the 
ParaView manual (docs.paraview.org). 
 

Table 4 | Software suggested to read and visualise *.vtk 

Software Platform License Website 
ParaView Unix/Linux, 

macOS,  
MS Windows 

Free (3BSD) www.paraview.org 

3BSD: 3-clause BSD 
 
 
4.3.2. Reading *.obj 
The *.obj files can be opened in most CAD software (Table 5). Many of these CAD programs support the 
included PDT map texture, allowing to use the models as a reference in CAD designing products 
interfacing with the human head, face and/or neck. Free and open-source alternatives to view and edit 
the *.obj can be found in Table 5, although these software are not intended for CAD.  
 
For a comprehensive list of 3D modelling software, see e.g. 
https://en.wikipedia.org/wiki/List_of_3D_modeling_software. 
 

Table 5 | Software suggested to read *.obj 

Software Platform License Website Suggested 
Use 

Fusion 360 macOS,  
MS Windows 

Commercial (PCS) www.autodesk.com/products/ 
fusion-360 

Viewer, 
CAD 

Rhinoceros macOS,  
MS Windows 

Commercial (PCS www.rhino3d.com Viewer, 
CAD 

SolidWorks MS Windows Commercial (PCS) www.solidworks.com Viewer, 
CAD 

Inventor MS Windows Commercial (PCS) www.autodesk.com/products/ 
inventor 

Viewer, 
CAD 

CATIA MS Windows Commercial (PCS) www.3ds.com/products-
services/catia 

CAD 

Preview macOS Free (PCS) www.apple.com/macos 
 

Viewer 

3D Viewer MS Windows Free (PCS) www.apps.microsoft.com/store/ 
detail/3d-viewer/9NBLGGH42THS 

Viewer 

ParaView Unix/Linux, 
macOS,  
MS Windows 

Free (3BSD) www.paraview.org Viewer, 
Editor 

MeshLab Linux, 
macOS,  
MS Windows 

Free (GPL) www.meshlab.net Viewer, 
Editor 

Blender Linux, 
macOS,  
MS Windows 

Free (GPL) www.blender.org Viewer, 
Editor 

Meshmixer MS Windows Free (PCS) www.meshmixer.com Viewer, 
Editor 

PCS: Proprietary commercial software 
3BSD: 3-clause BSD 
GPL: GNU General Public License 
 



README Dense 3D pressure discomfort threshold (PDT) map of the human head, face and neck 
M. Smulders & T. Huysmans 2022 CC-BY 4.0 

 17 

Please note that all nonNormalised maps are expressed in PDT (pressure discomfort threshold), where 
the Normalised maps are expressed as % of Mean 5% Max PDT. The nonNormalised_mean maps are 
ranged from 0-20 N or 0-254.6 kPa and the SD maps between 0-10 N or 0-127.3 kPa, where the 
Normalised_mean maps range from 0-100% and the SD maps between 0-40% (see Figure 12 for a 
legenda for colour interpretation or the journal publication).  
 
Please note that values of Normalised may exceed 100% in certain individuals. 
 

 
Figure 12 | Legenda for *.obj color interpretation. Please see also Smulders et al. (2022)  
Dense 3D pressure discomfort threshold (PDT) map of the human head, face and neck. 

 
 
4.3.3. Standards and calibration information  
All instruments were factory calibrated. 
File standards are shown in Table 6. 
 

Table 6 | File standards used 

File type Standard 
*.csv RFC 4180 
*.obj Wavefront obj format 
*.pdf ISO 32000-2 
*.vtk ASCII / Kitware VTK File Format 

 
 
4.3.4. Use of Eigenmodes to create principal component head models 
The models Smulders (2022) CAESAR PDT_Mean_nonNorm.vtk and Smulders (2022) CAESAR 
PDT_Mean_Norm.vtk contain the PDT maps superimposed on the average head shape derived from the 
CAESAR database (Robinette et al., 2002). In addition to this, the individual principal components (shape 
modes) are also included. This allows one to create virtually any plausible head shape as a combination 
of the average head shape and a weighted combination of the shape modes. 
 
The principal components are embedded in the models as vector fields over the mesh vertices. The 
vectors are scaled so that a weight of -1 or +1 corresponds to an offset of -3 or +3 standard deviations 
along that principal component. The software ParaView allows one to easily create such a custom head 
shape from the model (see Table 7). Please note that the PC range is limited to 1-50. 
 

Table 7 | Software needed to create principal component head models with Eigenmodes 

Software Platform License Website 
ParaView Unix/Linux, 

macOS,  
MS Windows 

Free (3BSD) www.paraview.org 
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Step 1 | Select model and set PDT map 
Follow the following steps in Figure 13: 
1. Open the 'Smulders (2022) CAESAR *' *.vtk files in ParaView. 
2. Press the eye icon [1] to activate one of the *.vtk models. 
3. Select the coloring [2] layer you want to activate [3], e.g. PDT_all_mean. 
4. Make sure the Range [4] is set correctly (see Table 10) in the field [5] and press [6]. 
 

 
Figure 13 | Select model and prepare for export (ParaView) 

 
Table 8 | Recommended ParaView range settings for PDT maps 

Dataset Normalisation Map type Range 
CAESAR nonNorm mean 0-20 [N] 

std 0-10 [N] 
Norm mean 0-100 [%]1 

std 0-40 [%] 
TUDELFT nonNorm mean 0-20 [N] 

std 0-10 [N] 
Norm mean 0-100 [%]1 

std 0-40 [%] 
1Data may exceed 100% in certain individuals. 
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Step 2 | Apply 'Warp By Vector' filter 
Follow the following steps in Figure 14: 
5. Press Filters > Search... [7] (or press Mac: ⌥	+	Spacebar | Windows: Alt + Spacebar) 
6. Type "warp by vector" to search [8], press Enter to select the Warp By Vector filter [9]  

(use keys to navigate up or down in selection list, press Enter to select, press Esc to exit search). 
7. The Warp By Vector filter of Model_Eigenmode_0001 with weight factor 1.0 (+3σ) is automatically 

applied. 
 
 

 
Figure 14 | Apply 'Warp By Vector' filter to create Eigenmode model (ParaView) 
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Step 2 | Change and apply shape modes 
Follow the following steps in Figure 15: 
8. The weight factor of Model_Eigenmode_0001 can be changed in field Scale Factor [10] between  

-1.0 (-3σ) and 1.0 (+3σ). 0 results in no vector applied. 
9. The desired shape mode can be changed in drop-down menu Vectors [11], showing all 

Model_Eigenmode_0001-0050. Click on the Model_Eigenmode_* to apply [12].  

Please note that evetime one Model_Eigenmode_* is selected, it is automatically 
applied with weight factor 1.0 (+3σ). This can be changed in Scale Factor [10]. 
Multuple Model_Eigenmode_* can be applied to create the desired model. 

10. The coloring [13] and Range [14] can be still adjusted if needed within WrapByVector1. 
 
To export the created Eigenmode PDT map, see §4.3.5 step 2-4. 
 

 
Figure 15 | Change the 'Warp By Vector' filter to customise Eigenmode model (ParaView) 
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4.3.5. Make *obj's from ParaView for CAD with MeshLab 
Unfortunately, ParaView (v5.10.0) cannot export *.obj with textures. But with a detour via MeshLab you 
can create *.obj files with textures of ParaView *.vtk models. Please see Table 9 for software needed. 
 

Table 9 | Software needed to create *.obj's from *.vtk's 

Software Platform License Website 
ParaView Unix/Linux, macOS,  

MS Windows 
Free (3BSD) www.paraview.org 

MeshLab Linux, macOS,  
MS Windows 

Free (GPL) www.meshlab.net 

 
 
Step 1 | Select model and set PDT map 
Follow the following steps in Figure 16: 
1. Open the *.vtk files in ParaView. 
2. Press the eye icon [1] to activate one of the *.vtk models. 
3. Select the coloring [2] layer you want to activate [3], e.g. PDT_all_mean. 
4. Make sure the Range [4] is set correctly (see Table 10) in the field [5] and press [6]. 
 

Table 10 | Recommended ParaView range settings for PDT maps 

Dataset Normalisation Map type Range 
CAESAR nonNorm mean 0-20 [N] 

std 0-10 [N] 
Norm mean 0-100 [%]1 

std 0-40 [%] 
TUDELFT nonNorm mean 0-20 [N] 

std 0-10 [N] 
Norm mean 0-100 [%]1 

std 0-40 [%] 
1Data may exceed 100% in certain individuals. 
 

 
Figure 16 | Select model and prepare for export (ParaView) 
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Step 2 | Save model as *.ply 
Follow the following steps in Figure 17 and Figure 18: 
11. Press File > Save Data... [7] (or press Mac: ⌘	+	S | Windows: Crtl + S) 
12. Select the correct output folder where you want to save your files [8] 
13. Create a logical name for your export file [9] 
14. Click on file type [10] and select PLY Polygonal File Formal (*.ply) [11] 
15. Click OK [12] (or press Enter) 
16. In the new window, under Color options select Enable Coloring [13] 
17. Click OK [14] (or press Enter) 
 

 
Figure 17 | Save model as *.ply (ParaView) 

 
Figure 18 | Save model as *.ply and Enable Coloring (ParaView) 
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Step 3 | Open *.ply model 
Follow the following steps in Figure 19: 
18. Start MeshLab. 
19. Press File > Import Mesh... [15] (or press Mac: ⌘	+	I | Windows: Crtl + I) 
20. Select the correct *.ply file [16] 
21. Open the file by clicking Open [17] (or press Enter) 
 

 
Figure 19 | Open .PLY model (MeshLab) 

Step 4 | Save model as *.obj 
Follow the following steps in Figure 20 & Figure 21: 
22. Press File > Export Mesh As... [18] (or press Mac: ⇧	+	⌘	+	E | Windows: Crtl + Shift + E) 
23. Click file format [19]  
24. Select Alias Wavefront Object (*.obj) [20] 
25. Click Save (or press Enter) [21] 
26. Click OK (or press Enter) [22] 
 
You now have an *.obj file of the selected *.vtk model, which can be used in e.g. CAD as an underlayer 
for designing products that interface with the human head, face and neck. 
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Figure 20 | Save model as *.obj (MeshLab) 

 

 
Figure 21 | Save model as *.obj with Color and Normals (MeshLab) 
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4.4. Experimental conditions 
Data is collected in a controlled lab environment (room temperature) at the Faculty of Industrial Design 
Engineering, Delft University of Technology. 
 
 
4.5. Describe any quality-assurance procedures performed on the data 
Visual inspections of models in Artec Studio, R3DS Wrap and ParaView. 
Backup photographs of landmark placement for landmark identification. 
PDT values visually inspected and checked with control (average) values in Excel. 
Use of high-quality 3D scanner and pressure gauge. 
 
 
4.6. People involved with sample collection, processing, 

analysis and/or submission 
 
 
Lead Author/Lead Investigator/Data analyst 
Name:  Maxim Smulders 
ORCID:  0000-0001-9957-0991 

Institution:  Faculty of Industrial Design Engineering 
Delft University of Technology 

Address:  Landbergstraat 15 
2628CE Delft 
The Netherlands 

Email:  m.smulders@tudelft.nl 
 
 
Author/Investigator  
Name:  Lisanne N.M. van Dijk 
ORCID:  0000-0002-8626-7296 

Institution:  Crescent Medical B.V. 
Address:  Vlamingstraat 72A 

2611KZ Delft 
The Netherlands 

 
 
Author/Investigator/Data analyst 
Name:  Yu (Wolf) Song 
ORCID:  0000-0002-9542-1312 

Institution:  Faculty of Industrial Design Engineering 
Delft University of Technology 

Address:  Landbergstraat 15 
2628CE Delft 
The Netherlands 

Email:  y.song@tudelft.nl 
 
 
Author/Investigator  
Name:  Peter Vink 
ORCID:  0000-0001-9985-3369 

Institution:  Faculty of Industrial Design Engineering 
Delft University of Technology 

Address:  Landbergstraat 15 
2628CE Delft 
The Netherlands 

Email:  p.vink@tudelft.nl 

Author/Principal Investigator/Lead data analyst 
Name:  Toon Huysmans 
ORCID:  0000-0001-7053-6458 

Institution1:  Faculty of Industrial Design Engineering 
Delft University of Technology 

Address1:  Landbergstraat 15 
2628CE Delft 
The Netherlands 

Email1:  t.huysmans@tudelft.nl 
 
 
Institution2: Imec-Vision Lab 

Department of Physics 
University of Antwerp 

Address2:  Universiteitsplein 1 
B-2610 Antwerp 
Belgium 

 
 
Lab manager 
Name:  B.J. Naagen 

Institution:  Faculty of Industrial Design Engineering 
Delft University of Technology 

Address:  Landbergstraat 15 
2628CE Delft 
The Netherlands 

Email:  b.j.naagen@tudelft.nl 
 
 
Lab assistant (guest) 
Name:  Liliana Di Brigida 
ORCID:  0000-0002-6324-2678 

Institution:  Dipartimento di Ingegneria Industriale 
University of Salerno 

Address:  Via Giovanni Paolo II 132 
84084 Fisciano SA 
Italy 
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5. DATA-SPECIFIC INFORMATION 
 
Below all data-specific information is given. Please note that datasets (e.g. *.vtk and *.csv) can be 
combined when they contain data with similar variables and cases/rows, but saved in different file 
formats. Please see §4.3 for recommended software to open the files. 
 
Smulders (2022) TUDELFT PDT_Mean_nonNorm.vtk1 

Smulders (2022) TUDELFT PDT_Mean_nonNorm.csv 
Smulders (2022) TUDELFT PDT_Mean_Norm.vtk1 

Smulders (2022) TUDELFT PDT_Mean_Norm.csv 
Number of variables: 38 
Number of cases/rows:  10153 
Variable List: 
 
*Range between 01-29 

Variable Explanation 
PDT_participant_* PDT values of individual 

participant in Newtons 
PDT_all_mean Mean PDT values of all 

participants (n=28) in 
Newtons 

PDT_all_std Standard deviation of 
PDT values of all 
participants (n=28) in 
Newtons 

PDT_male_mean Mean PDT values of all 
male participants 
(n=14) in Newtons 

PDT_male_std Standard deviation of 
PDT values of all male 
participants (n=14) in 
Newtons 

PDT_female_mean Mean PDT values of all 
female participants 
(n=14) in Newtons 

PDT_female_std Standard deviation of 
PDT values of all 
female participants 
(n=14) in Newtons 

valid_points All points that are 
within ROI (see  §4.2.5) 

Points:0 X-coordinate of point 
Points:1 Y-coordinate of point 
Points:2 Z-coordinate of point 

Missing data codes: 0 
Specialised formats or other abbreviations used: n.a. 

1 The *.vtk structure description can be found in §19.3 VTK File Formats of the The VTK User’s Guide 11th Edition (see 
https://www.kitware.com/products/books/VTKUsersGuide.pdf). 
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Smulders (2022) CAESAR PDT_Mean_nonNorm.vtk1 

Smulders (2022) CAESAR PDT_Mean_nonNorm.csv 
Smulders (2022) CAESAR PDT_Mean_Norm.vtk1 

Smulders (2022) CAESAR PDT_Mean_Norm.csv 
Number of variables: 188 
Number of cases/rows:  15118 
Variable List: 
 
* Range between 0001-0050 
** Range between 01-29 

Variable Explanation 
Model_Eigenmode_*:0 X-value of vector 
Model_Eigenmode_*:1 Y-value of vector 
Model_Eigenmode_*:2 Z-value of vector 
PDT_participant_** PDT values of individual 

participant in Newtons 
PDT_all_mean Mean PDT values of all 

participants (n=28) in 
Newtons 

PDT_all_std Standard deviation of 
PDT values of all 
participants (n=28) in 
Newtons 

PDT_male_mean Mean PDT values of all 
male participants 
(n=14) in Newtons 

PDT_male_std Standard deviation of 
PDT values of all male 
participants (n=14) in 
Newtons 

PDT_female_mean Mean PDT values of all 
female participants 
(n=14) in Newtons 

PDT_female_std Standard deviation of 
PDT values of all 
female participants 
(n=14) in Newtons 

valid_points All points that are 
within ROI (see  §4.2.5) 

Points:0 X-coordinate of point 
Points:1 Y-coordinate of point 
Points:2 Z-coordinate of point 

Missing data codes: 0 
Specialised formats or other abbreviations used: n.a. 

1 The *.vtk structure description can be found in §19.3 VTK File Formats of the The VTK User’s Guide 11th Edition by Kitware and 
Sandia National Laboratories (see https://www.kitware.com/products/books/VTKUsersGuide.pdf).  
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Smulders (2022) Participant_characteristics.csv 
Number of variables: 6 
Number of cases/rows:  28 
Variable List: Variable Explanation 

Participant ID Unique participant 
number 

Gender [M/F/X] Gender, as described 
as Male / Female / X 
(Non-binary or not 
given) 

Ethnicity Ethnical heritage from 
parents, expressed as 
nationality. 

Age [y] Age in years 
Height [cm] Stature height in 

centimetres 
Weight [kg] Weight in kilograms 

Missing data codes: 0 
Specialised formats or other abbreviations used: Abbreviation Meaning 

M/F/X Gender Male / Female / 
X (Non-binary or not 
given) 

y  years (based on date of 
birth and date of test) 

cm  centimetre (SI unit) 
kg kilogram (SI unit) 

 
 
Smulders (2022) Original PDT_data.zip1,2 

Number of variables:  
Number of cases/rows:   
Variable List: 
 
 
* Range between 01-29 

Variable Explanation 
Original_Head Average head model 

based on 3D geometry 
of all participants 
(n=28) from study 
Smulders et al. (2022) 

Original_PDT_participant_* Point 3D coordinates 
with corresponding 
PDT values of 
individual participant  
from study Smulders 
et al. (2022) 

Missing data codes: 0 
Specialised formats or other abbreviations 
used: 

.obj 

.vtk 
1 The *.vtk structure description can be found in §19.3 VTK File Formats of the The VTK User’s Guide 11th Edition by Kitware and 
Sandia National Laboratories (see https://www.kitware.com/products/books/VTKUsersGuide.pdf). 
2 The *.obj structure description can be found in Appendix B1. Object Files (.obj) of the Advanced Visualizer Manual by Wavefront 
Technologies (since 2006 part of Autodesk) (see http://fegemo.github.io/cefet-cg/attachments/obj-spec.pdf). For more details, see 
also Wavefront OBJ File Format by the Library of Congress Collections, USA (see 
https://www.loc.gov/preservation/digital/formats/fdd/fdd000507.shtml). 
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Smulders (2022) OBJ PDT_maps.zip2 

Number of variables: 1 
Number of cases/rows:  24 
Variable List: Variable Explanation 

CAESAR Models based on 3D 
geometry from 
CAESAR database by 
Robinette et al. (2002) 

TUDELFT Models based on 3D 
geometry from study 
Smulders et al. (2022) 

nonNorm non-normalised 
Norm normalised 
PDT_all_mean Mean PDT values of all 

participants (n=28) in 
Newtons 

PDT_all_std Standard deviation of 
PDT values of all 
participants (n=28) in 
Newtons 

PDT_male_mean Mean PDT values of all 
male participants 
(n=14) in Newtons 

PDT_male_std Standard deviation of 
PDT values of all male 
participants (n=14) in 
Newtons 

PDT_female_mean Mean PDT values of all 
female participants 
(n=14) in Newtons 

PDT_female_std Standard deviation of 
PDT values of all 
female participants 
(n=14) in Newtons 

Missing data codes: 0 
Specialised formats or other abbreviations used: .obj 

2 The *.obj structure description can be found in Appendix B1. Object Files (.obj) of the Advanced Visualizer Manual by Wavefront 
Technologies (since 2006 part of Autodesk) (see http://fegemo.github.io/cefet-cg/attachments/obj-spec.pdf). For more details, see 
also Wavefront OBJ File Format by the Library of Congress Collections, USA (see 
https://www.loc.gov/preservation/digital/formats/fdd/fdd000507.shtml). 
 
 
 
 
 
 
 
 
 


